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Special News Alert:

AVG updates free Anti Virus software

AVG has just launched the 2011 version of its free antivirus software.
It has most of the features from AVG's paid antivirus. These features
will better serve AVG's free antivirus users. AVG already supports an
estimated 110 million users.

The free AVG antivirus offers the same great level of protection as
always. It constantly updates scanner information from AVG's online
network. And it continually scans when the computer isn't in use.

AVG free now includes AVG's LinkScanner. This scans Web links in
real time as you surf.
It can detect if a link leads to a malicious Website.

Then it will warn you and stop any malicious programs from activat-
ing. This also works on links from social networks like Facebook.
AVG can also guard against other social networking threats.

That includes malicious communications from compromised accounts.

That's a lot of protection from a free product. If you already use AVG,
be sure to upgrade.
Those who don't use it can download it from here:

www.komando.com/downloads/
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Minutes of the meetings
No minutes available from the meeting at the Riverview Library.
However, there was good news.

It was announced that the group has fulfilled the requirements of the school district, and classes
began on October 26th.

Minutes of the class October 26.2010

Again, as in the previous classes, Parker gave a detailed report about the situation for the club’s
class room at the Brandon High School. Treasurer Gary Staley did a lot of work at the project and
finally was excepted as the “Professor” all we need now are the students. No problem here.

It also was brought up for the member to decide if the meetings should be reduced to three nights
from the current four nights.

Parker led the Fundamentals class. It was reported that Microsoft’s Internet Security Essentials be-
comes more and more popular, meaning that it must do what it is supposed to do, keep your PC free
from unwanted and malicious intruders. Still free for the download. A couple of members noticed a
slowdown of the Brighthouse RR Internet connection. However, Brighthouse would be the one to call
about, if the Computer’s setup and configuration is set correctly and free of Mal-and Spyware. A
100% usage of the processor was noticed in the Task Manager of one member’s PC and again this
could be a sign of an unwanted infiltration and/or his pc has become a zombie.

Unable to open certain files sent by e-mail, Microsoft’s free file-viewer might come in handy, along
with the picture viewer and Power Point viewer.

At the class to be held on Nov. 15th, a guest presenter from the Tampa PC User Group will cover
the very popular Twitter and FaceBook services.
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Election is coming!

With election state- and nationwide upon us, the GTBPCUG members also will have to decide be-
fore the year is up, who the officers will be in 2011. Between now and then, members can send in
their names with the desire for what position he or she would like to be nominated for election.
The current officers of course can feel free to seek re-election.

All the elected positions, including the newsletter editor, are strictly volunteer positions.

Naturally, | only can speak for myself when | say the position of news letter editor may be vacant
early next year if no one volunteers to take over as editor.

Doing this job for about 2 years, | feel the time has come that someone else should give it a try edit-
ing the GTBPCUG Newsletter.

| feel this position should be filled by someone more familiar with all the new technology in the field
of computing as well as the constantly changing line of gadgets and accessories.

Never been to “MySpace” or “YouTube”, don’t have an account in “FaceBook” and use my cell
phone only to add more minutes to it. GPS has not yet replaced the latest AAA Florida map in my
car and | always thought Blackberries make a delicious pie.

The GTBPCUG newsletter needs an editor more up on the latest stuff when it comes to inform the
members.

However, | will continue until one member steps forward to take over. | will assist fully with the task
on hand unless one is totally familiar with desktop publishing and the Microsoft Publisher Software.

Al Droll
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Officer nominations for 2011 are:

President: Jo Ann Brawner

Vice President:

Treasurer: Gary Staley
Secretary: Patrick Courtney
Membership:

Program Coordinator: Sherry Foecking

Web Master: Parker Monroe

Newsletter Editor Al Droll
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Antivirus up to date?
Firewall?

Windows up to date?
Spy Ware?

See how to protect your computer at:

http://www.gtbpcug.org/protect/

More about Internet Threats

The link to this article was submitted by Charlie Vanderford

October 14, 2010 by shogan in The Pit Blog
http://techtalk.pcpitstop.com/2010/10/14/iran-go-boom-mommie/?

Most Important Windows Security Patch Ever

For the past 7 years Microsoft has released security patches for their products on the second
Tuesday of each month. Following tradition, Microsoft just issued its largest security patch ever on
October 12th, Patch Tuesday. Let me say again that this is the largest patch ever from Microsoft.
A total of 49 vulnerabilities are fixed with 16 patches and this far exceeds the previous record of 34.

One of the most notorious exploits, that was mostly fixed, was the Stuxnet virus. This is the virus that
attacked the Bushehr nuclear power plant in Iran earlier this year. | think it was a mistake when we
coined the word "virus" to describe these attacks. We forget that what we call a virus is a direct
attack by an individual or group. It's almost as if we accept virus activity like we would accept having
a cold. Make no mistake, this virus is not about a few stolen credit card numbers. There is a war
going on. There are good guys and bad guys.

The good guys are called "White Hat Hackers", the bad guys are called "Black Hat Hackers", and
they are locked in mortal combat.

The introduction of the Stuxnet Virus changed the game. It amazed and horrified all the current
experts. The attack on Bushehr was and still is, a big deal. The Stuxnet virus attacked a physical
plant, and a nuclear plant at that. No longer a simple attack on software but a full blown attack on
hard objects. Continued on the next page
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This absolutely marks the beginning of a new era. The beginning of digital strikes against physical
targets. The results can be the same as if someone dropped a bomb on your city .

Stuxnet took months of preparation and a level of expertise that was previously unknown. A bag of
new tactics that infected without internet connections, without the click of a button. The sophistica-
tion was staggering.

There's little doubt that the attack was the work of a well trained group or nation and not the work of
individuals.

Suddenly my monthly discussions with good friend and Apple user Bill R. seem rather unimportant.
Now | realize that while protecting my computer is a must, it's not the whole issue. The real issue is
much bigger and much more ominous. The real issue is about the safety of nations and families.
I've never looked to see where or how many nuclear plants were in the US, but a quick Google
search let me know that unless | move to Oregon or North Dakota, I've got every chance of glowing
like a light bulb if someone decides to launch a similar attack in the US.

What to do?

1. Do your part and update immediately. Be sure to mark it on your calendar to updated every Patch
Tuesday.

2. Purchase a good antivirus product. Find a product that doesn't waste resources and slow your
system to the point that you disable it. Find one that updates automatically and offers real time
protection. Remember you're only as your most recent update. In fact, the most dangerous time is
immediately after Patch Tuesday on Hacker Wednesday.

The hackers take advantage of those who don't update right away.

3. Continue to be cautious when receiving and opening email.

4. Avoid visiting Social Networks and unprotected file sharing sites. There is no protection when you
intentionally click the download button. It's up to you to decide whether the person on the other end
is clear of infection.

5. Enjoy the protection that comes with Cloud Computing. It's going to be one of the biggest shifts in
how computing is done. Eventually all of your applications and programs will be kept on a server and
not your computer. It's the future and PC Pitstop is a part of it. All of our programs are in The Clouds.
Get on board.
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Microsoft Offers Free Online Version of Office

by Ira Wilsker
WEBSITE: http://www.live.com (Click on "Office")

In the over 10 years | have been writing this weekly column | have used the Microsoft Word in-
stalled on my desktop computer for all but a handful of the columns. There were a few columns |
wrote while using Open Office as a topic of the column; one column was typed using Google Docs
and saved as a Word file to send to my editor. Today | am using Microsoft's recently released Word
Web App, which is one of the several Office utilities now available for free at www.live.com.

Since these applications are online, they can be accessed from anywhere the user has internet
access, and are utilized in a browser window.

From the live.com webpage, the office applications can be utilized by clicking on the "Office" link
at the top of the page. Word, Excel, PowerPoint, and OneNote are currently available. Registration
is required in order to use the Microsoft Live utilities, but registration is fast and free.

For those users who may need access to the primary components of Microsoft Office, but do not
have it installed on their computers, this service from Live is a viable alternative.

| started by using Live's Word Web App to type this column. The "ribbon" or menu at the top of
the browser window is reminiscent of the one in Word 2007, but does not have quite as many
choices as the full version of Word 2007 on my computer. While all of the major functions are avail-
able, many of the enhancements and "bells and whistles" are not available on the web version.
The top line menu choices are "File", "Home", "Insert", and "View". Above the ribbon are small icons
to save and undo. Clicking on the "File" tab gives the user choices to open, save, share, close,
properties, feedback, and privacy. As | am typing this, | am periodically saving the file in the de-
fault .docx (Word 2007) format to Microsoft's SkyDrive, which is Microsoft's server sometimes re-
ferred to as "in the cloud". Once saved to the SkyDrive, | can access this file from anywhere.

The default tab on the Word Web App is "Home" which displays the simplified Word 2007 ribbon
(menu) with the ubiquitous copy, paste, fonts, formatting, spell check, and another feature which is
not in the computer based version of Word, "Open in Word". This "Open in Word" will connect to the
Word installed on the computer, and open the document in the computer based Word, but only if a
compatible browser is being used. | am using Firefox as my browser as | type this, and clicking on
the "Open in Word" icon on the ribbon displays a message that my browser is not compatible.
Another anomaly (browser incompatibility) occurred when | tried to copy some text by painting it,
right clicking and going to "copy". A window opened that said, "Your browser does not allow access
to the clipboard. Use the keyboard shortcuts for cut, copy, and paste instead." Using the keyboard
commands CTRL-C allowed me to copy the text | wanted, and CTRL-V allowed me to paste it where
| wanted it. This inability to work nicely with some browsers other than Microsoft's lowers my opin-
ions of this product; while it is not a fatal defect, | do not like the idea of being compelled to use Inter-
net Explorer in order to utilize all of the features of the Word Web App. The "Insert" tab on the rib-
bon allows the user to insert a table, picture, clip art or links.

Continued on the next page
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The "View" tab offers the user the choice of an "Editing View" and a "Reading View".
One important item missing from the menu is a "Print" button; | could not find any easy way to print a
document, other than using the browser print function.

While Word may be one of the most widely used applications, Excel and PowerPoint are also
very widely used. The online version of Excel can be accessed by clicking on the Excel icon on the
Live - Office web page. The Excel Web App looks much like a simplified version of the full com-
puter based version of Excel, and uses the same interface and commands. By default, files are
saved to the SkyDrive in the Excel 2007 .xIsx format. The first thing | noticed on the Excel Web App
is that the formula bar (Fx) does not pull down to display the list of available formulae. 1 also found
that the auto-fill functions where dates and cells could be auto-filled by clicking on the corner of a
cell and dragging does not work, at least when used in Firefox. The ribbon bar on the Excel Web
App looks much like a simplified Excel 2007 menu bar, but lacks some of the choices available on
the computer installed version. As with the other Microsoft Web Apps, the spreadsheet can be
shared as desired. Also as with the Word App, the icon "Open in Excel" will generate an error.
According to the online help, none of the Web Apps will open the computer's Office if using Firefox
and Office 2003 or Office 2007; Microsoft's recommended fix is to install Office 2010. The online
help also says that the 64-bit version of Internet Explorer is not supported, and that browsers other
than Internet Explorer and Firefox are not supported at all. That means that it may be difficult or im-
possible for the many users of Chrome, Safari, Opera, and other browsers to utilize these otherwise
useful Web Apps.

| do a lot of PowerPoint presentations, and | was especially interested to try the PowerPoint Web
App. As with the other apps, it saves in the Office 2007 formats, in this case .pptx. The screen
looks familiar, but much simplified from the full version of PowerPoint. One item obviously missing
from the ribbon (menu) is the "save" button; that is because the PowerPoint Web App automatically
saves the presentation. Another feature that is missing is the ability to right click on an image or
text box in a slide to add animations or special effects. | easily inserted an image into a slide, and
was given a choice of eight picture styles or frames, but could not animate or otherwise add the spe-
cial effects that | sometimes use in the full version. Other than using some of the more sophisticated
features of the full version of PowerPoint, the Web App version is adequate for simple PowerPoint
presentations.

| will admit that | do not use Microsoft's OneNote, but it is available as a Web App. Looking
much like a Word document, with the addition of a calendar line, when shared, it also shows the
other authors and page versions that were accessed and modified. OneNote also allows for im-
ages, clipart, links, and tables to be inserted, which can provide a richer user experience. Like
Word, the ribbon (menu) in OneNote allows the user to implement traditional formatting and fonts as
desired. | could see where OneNote would be useful for taking notes and sharing content.
As with PowerPoint, there is no "save" button, as OneNote documents are automatically saved.

Continued on the next page
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The user can then drag and drop files from his computer into the "Add Files" browser window, or
files can be uploaded to SkyDrive by clicking on "Select documents from your computer". Docu-
ments and other files stored on SkyDrive can be downloaded individually in native format, or all of
the files can be downloaded together as a single ZIP file from SkyDrive. | experimented with Sky-
Drive and the Web Apps and found that this may be a viable choice either as a primary or backup
method of doing presentations or working on documents away from my home or office computer,
providing there is good internet access. Clicking on the SkyDrive "More" link allows the user to view
a file's properties, or delete it from SkyDrive.

One of the strengths of using web applications like these is the ability to work together or collabo-
rate on projects. By clicking on FILE - SHARE others can be authorized to access the file.
The share choices can be controlled with a slider that ranges from "Just me" to "Some friends",
"Friends", "My friends and their friends", and "Everyone (public)". Specific people can be added to
those eligible to share by name or by email address.

While not as feature rich as the full versions of Office, the free Web Apps versions at live.com do
offer a viable alternative to those who do not have Office installed on their computers, or who need a
portable version of those applications. Many users will find these Web Apps quite useful.

PCMover Essentials
By Terry Currier, President, WINNERS (Windows users), California

E: PCmower Professional

PCmove

mMethod of Migration

The magration can be completad several ways. Please choose from the following

t Metwork
- Both computers rmest be on the Local frea Metwork (LAMN]),

Laplink Ethernet Cabile
Connect bwo computers with a Laplink Ethermet cable,

File Storage Device
Choose from warious devices such &< a DYD, USB Stick, or External FHard Drive.

windows 7 Upgrade Assistant

-'?_.--: - Perform this step before and after a Windows 7 Upgrade
USE Cabbe
-.A “With PCrnover instabad on esch PC, plug i the USE cable now.
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Continued on the next page
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PC Mover Essentials
By Terry Currier, President, WINNERS (Windows users), California
June 2010 issue, The Notepad

www.windowsusers.org

tcurrier (at) aol.com

PC Mover from Laplink allows you to move files quickly and easily from one computer to another.
Depending on which version you get they include an easy transfer USB cable in the box to help you
with this. But, what | was trying to do was have it help me upgrade my Windows XP to Windows 7.
Laplink does make Laplink PCmover Windows 7 Upgrade Assistant at a lower price ($17.99 at
Buy.com), but | saw this at Costco and picked this up for $38.99.

| thought | would give it a go on my old test computer which really should not accept Windows 7. It is
has a Pentium 4 processor with 1.7MHz speed and only 512Mb of RAM. In fact, | updated the Win-
dows XP operating system and went Intel to see if there were any updates for the BIOS for my
motherboard. There were none, and Intel said there were no plans for updating that motherboard for
Windows 7. Of course, | was still going to try.

| also thought | would try another test of the Rebit backup program. | reviewed it last month and
found it to be quite good, but here would be a test where | could use it to restore from the full image.
| found it interesting that even though Rebit ONLY works with an external drive, it would not see
mine. Windows saw it. Rebit only gave me a popup saying another system has already backed up to
it (the external drive.)

There was plenty of space on it, and the Rebit license permits me up to six computers to be backed
up. However, for some reason Rebit did create a backup onto a separate internal drive.

You can probably guess, Windows 7 would not install on the old computer. Attempting to do so just
created an error message about the IDE and would not even try to install. So | did not need that
Rebit backup after all.

So | turned to do the upgrade on my main computer. It has Intel Core 2 Duo at 2.40GHz

with 2GB of RAM. I'm using the Windows 7 Family Upgrade package, from which you

can upgrade three computers. I've already upgraded my two Vista computers (hooray.)

Again, | installed Rebit and did a complete backup. Also | did backup my data to another

drive, so | was fully covered before doing the upgrade.

On the PC Mover install disc it also mentioned | could download a trial version of its Laplink Disk Im-
age program. | figured what the heck and really covered myself. | downloaded a 30-day trial version
of the program and was really impressed with the setup. It is very easy to use and it installs under
programs which Rebit does not. | found the image size to be about one-third the size of Rebit, and

took about one-third the time to create. For emergency restore you do need the box version since it
has the restore feature on the install disc.

After that was completed, | installed the PCMover Essentials program and ran it. | should tell you
that the program is licensed for one computer, and it stopped me from using it on another computer.
It directed me to their support desk. | got on-line with them in a chat mode and explained what | did.
The rep then gave me another license to use and | was good to go.

Continued on the next page
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PCMover warned me that software or music files with copyright protection may not be able to trans-
fer that license, and hardware drivers would not be moved. It then presented the upgrade assistant
screen telling me just which steps to do.

Next PCmover gets ready to copy all the settings and applications to an external media file they call
the moving van. You should uninstall any programs you don’t want before the upgrade. However,
PCmover does give me the option to choose in advance which, if any, applications | don’t want to
migrate.

Once the moving van/upgrade file has been created, | ran the Windows 7 installation with the cus-
tom install which is needed for Windows XP. Windows 7 (64-bit replacing the 32-XP) installed with-
out a hitch. Just like it did with the Vista upgrade it creates a folder named Windows.old. It contains
the Documents and Settings (with the old My Documents folder,) Programs, and Windows folder
from my previous operating system.

| made sure everything was correct then installed and ran PCmover. It restored all applications,
data, and settings using the moving van from the external media. So, after all that is everything per-
fect? Aw come on, we know computers are never perfect. Most everything copied over correctly: Mi-
crosoft Office, Applian programs, SnaglT, Faststone, Total Recorder, my web editor, and others.
Adobe Premiere Elements 7 and Photoshop Elements 7 did not work so | did had to reinstall them.
My ADS DVD Express did not work, but it did not work when | tried to install it onto a Vista computer
so | knew it would not work with Windows 7. | moved it over to my old computer which, of course,
still has XP on it.

| had only two problem: First, my optical drives would not work. They showed up in Device Manager,
but Windows Explorer could not see them. | had to delete them from the Device Manager and reboot
before | could get them to work properly. Second, when | would bring up files to work on in Excel,
Word, or my Namo web editor | could not save changes to them. The program would bring them up
as “read only.” Windows Explorer showed the files not to be read only. It was driving me crazy. To fix
it | tried going into the User Access Control and lowered the restrictions. That made no difference.

| right clicked on my C: drive and then clicked on properties. From there | checked Security. While
Administrator has full access checked, | did not, even though | have administrator rights. So | tried to
edit that to give me full control. Windows tried to make the changes but failed for security reasons.

| looked for an answer on-line, but only found what | already tried. So what | did was to use Windows
Explorer and right clicked each of the folders with the files | wanted to work on. | then went through
and gave myself full control over that folder, and that worked. From what | read on-line this happens
only in the upgrade from Windows XP to Windows 7.

An interesting note, normally | had problems with video editing. Both CyberLink PowerDirector and
Adobe Premiere Elements sometimes would shut down on me. Of course, that could be because |
had three video editors on the computer, but | don’t think so. Now with Windows 7, they are running
great and no shut downs. It could either be Windows 7, or | got rid of something else that was inter-
fering with them. Anyway, everything is working great and it is really nice having Windows 7.

The only thing | need now is get some more memory. One of the gadgets | installed showed my
average RAM usage with just Windows is about 42%. With Word, Windows Explorer, Outlook, and
three windows of Internet Explorer it is using 66%. I’'m going to get another 6GB of RAM to smooth it
out.

On my other desktop computer with Windows 7 and 4GB of RAM the usage with just windows is
about 32%. in the future | want ton install a bigger hard drive and take the computer off the RAID 0 it
came with.
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The web

Legal Notice

Bay Bytes, Copyright © 2010, is the official newsletter of the Greater Tampa Bay PC User Group, Inc.(GTBPCUG). The information in this newsletter is in-
tended to help our members. It has come from many sources and cannot always be verified. It is recommended that you obtain professional advice from software and
hard ware distributors, manufacturers, salesmen, or other professionals dealing with the subjects that appear in this newsletter. Unless specifically stated otherwise,
the opinions expressed in Bay Bytes articles and columns are those of the individual authors and do not represent an official position of, or endorsement by
GTBPCUG.GTBPCUG is not affiliated with any company, vendor or equipment manufacturer. Permission for reproduction of Bay Bytes in whole or in part is
hereby granted to other APCUG user groups for internal, non-profit use, provided credit is given to the author, GTBPCUG Bay Bytes along with the copyright notice.
Other reproductions require the prior permission of the editor. When published, please send a copy of your newsletter to

editor@gtbpcug.org or mail to P.O.Box 501, Brandon, FL, 33509-0501.




